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5. SEMBAPRO™ SOFTWARE  

5.1. Starting the Program 

The Octave System is controlled by the SembaPro software, an Apple Macintosh-
based application. This software is preloaded on the computer supplied with the 
system and is available on the desktop. To begin, power up the Octave System as 
described in Section 4. Start up the computer by pressing the power button on the 
rear of the case. After the computer’s main window appears, double click on the 
program icon to start the SembaPro application. 

5.1.1 Installation 
If the program is being installed or an upgrade to the software is required, the 
program may be supplied by Semba as a compressed SembaPro.zip folder, which 
may also contain the .app file extension, with the “zipper” indicated in the folder icon 
on the desktop. 

If a prior version of the software is already present on the computer, first move the 
old version to another folder and rename it (to keep as a backup). To do this, double 
click on the Macintosh HD icon on the desktop, which will open the root directory on 
the hard drive. Double click on the Applications folder to open it, and drag the “old” 
SembaPro program icon from the desktop to this folder. To rename it, right click on 
the program icon, select “Get Info”, then click on “Name and extension” to expand 
the menu. Type in the new extension (e.g. .old) in place of .app and press return. 
Answer “yes” in the dialog box and close the Get Info window. Close the Macintosh 
HD window. 

Copy the .zip folder of the new program to the desktop by dragging it from its 
supplied location to the desktop. Double click on the folder. The new SembaPro 
program icon should appear on the desktop. To run the program, double click on this 
icon. 

5.2. Using the Program 

5.2.1 Opening Screen: the Current Valve State Window 
When the SembaPro program is first opened, the Current Valve State window 
appears (see Figure. 6). If the window does not appear, open it from the Window 
menu. The Current Valve State window shows the status of all nine valves for all 
eight columns, and allows control of individual valves. Before opening or closing any 
valves, first be sure that the pneumatic pressure on the system is activated as 
described in Section 4 and that all the valves are closed by clicking on the “Close all 
valves” button. No valve LED’s on the front panel should be lit after clicking this 
button. 
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Figure 6. SembaPro™ Current Valve State window 

5.2.2 Valve Names and Operation 
The first eight valve names listed for each column in the SembaPro application 
correspond to the inlet and outlet streams. Feed, Desorbent, Aux 1 In and Aux 2 In 
are the inlet streams connected to inlets A-D, respectively, and Extract, Raffinate, 
Aux 1 Out, and Aux 2 Out are the outlet streams connected to outlets E-H, 
respectively (see table below).  

Stream Inlet/Outlet Connection 
Feed A 
Desorbent B 
Aux 1 In C 
Aux 2 In D 
Extract E 
Raffinate F 
Aux 1 Out G 
Aux 2 Out H 

The “Shutoff” valve (I) indicates the valve that allows flow from one column in the 
series to the next.  

In the SembaPro application, the closed position is indicated by a checkmark in the 
box next to the valve name. To open a valve, click once on a checked box, which 
clears the box. The valve does not actually open until the “Update valve 
configuration” button at the top of the window is pressed (by clicking once). When 
this button is pressed a “pfft” sound should be heard from the valve block as the 
solenoid exhausts gas pressure, and the front panel LED corresponding to the 
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appropriate valve should light up. To close a valve, click on an open box to make a 
checkmark, and then click on the “Update valve configuration” button. There will be a 
brief “click” sound and the LED should turn off as the valve closes. 

If no sound is heard or the LED does not light up when the “Update valve 
configuration” button is pressed, make sure that the power up procedure described in 
Section 4 has been followed. If the LED lights up and no sound is heard, it is likely 
that the gas pressure is off or the nitrogen tank is empty. If there is both power to the 
unit and gas pressure and no response is observed when opening/closing valves, the 
SembaPro application may need to be restarted. This may occur if the computer 
goes into sleep (standby) mode while the application is running. To prevent the 
computer from going to sleep, click on the Apple menu on the far upper left of the 
main screen, and select System Preferences. In the System Preferences window 
click on Energy Saver (under “Hardware”). In the resulting window move both 
pointers to “Never” and uncheck the box next to “Put the hard disk(s) to sleep when 
possible.” Close the window by clicking on the red button on the top left corner. The 
computer will now remain awake until shut down or put to sleep manually. 

When the Current Valve State window is active, multiple valves can be opened and 
closed at the same time by checking/unchecking the desired boxes and then 
pressing the “Update valve configuration” button. 

The Current Valve State window is very useful for performing single or multicolumn 
operations that do not require a full program script. See Section 7.3 for additional 
information.  

5.2.3 Pump Control Window 
Pumps are normally controlled from the Script window (see next section). When the 
Script window is not open, pump flow rates and power can be controlled from the 
Pump Control window, which is accessed from the Window menu (see Figure 7). 
Each pump is individually controlled in the Manual Control option; simply double click 
on the white box next to the appropriate pump, enter the desired flow rate next to the 
appropriate pump and press enter or return on the keyboard. To switch a pump on or 
off (if using outside a script), click on the box next to the flow rate. A check mark 
indicates that the pump is on; a cleared box indicates that it is off. The pump speed 
may also be set by dragging to the pump scroll bar button with the mouse. 

 

 

 

 

 

 

 

 

 

 

Figure 7. SembaPro™ Pump Control window 
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5.3. Using Scripts 

5.3.1 Script Window 
Scripts are simple files that control the valves and pumps in a set program. To open 
an existing script, select Open under the File menu. Navigate to the desired script file 
and select to open it. The Script window appears (see Figure 8). 

In the Script window a “Step” column for entering program steps is displayed on the 
left side of the screen, as well as boxes for entering the duration of a step (switch 
time) in seconds, boxes for entering flow rates for the four pumps, and the valve 
status for all eight columns. 

Valve states for each column are displayed vertically under the column number 1-8 
headings. By clicking on the appropriate box under the column heading, the valve 
positions can be switched open (empty box) or closed (checked box).  

The buttons along the bottom of the window are used when programming and 
running the script.  

Button Function 

    + Add a step 

    – Delete selected step 

Loop – cycle repeats from step 1 when highlighted 

Pumps – pumps switch on with Start script command 
when highlighted 

The “+” and “–” buttons add or remove a step at the selected position and are used 
only in programming. The “loop” button, when highlighted, indicates that the script 
will repeat from step 1 after the last step is finished. To the right of the loop button is 
the “pump state” button. The pump state button, when highlighted, will start all pumps 
at the programmed flow rates when the “Start script” button next to it is clicked. The 
“Start script” button begins the script; when pressed the first step begins counting 
down according to its programmed time and the button name changes to read “Stop 
script.” A script can be stopped (interrupted) at any point by pressing the “Stop script” 
button during the run. All pumps will stop and all valves will remain at the state they 
were in when the Stop script button was clicked. When Stop script is pressed again, 
the pumps restart and countdown for that step resumes from the point where it 
stopped. 
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Figure 8. SembaPro™ Script window 

5.3.2 Creating a Script 
A new script can be written by selecting “New” from the File menu, or an existing 
script can be modified (after unlocking it, see below) by selecting “Open” and 
scrolling to an existing file to open it. Scripts can be created easily by using the open 
Script window to add or delete steps, program the switch time, valve states, and 
pump flow rates. 

After a script is created it can be “locked” to prevent accidental changes by clicking 
on the lock icon at the bottom of the window. If the lock icon at the bottom of the 
window is in the closed position, the script cannot be modified. The lock can be 
opened by clicking on it and entering the computer’s password in the dialog box. The 
default password is “sembabio”. 

To add a step, position the mouse pointer over the Step column in the row 
corresponding to where the step will be added, click to select the step, and then click 
the “+” button. A new step is created above the selected step. Selected steps may 
also be copied and pasted using standard commands. The Script window will show 
the valve configuration, pump flow rates, and length of each step or ‘switch time’ for 
the step that is highlighted in the Script window. Defaults for a new step are valves all 
“off”/closed/boxes checked, pump flow rates all 0, switch time 10 seconds, and “loop” 
on. To modify the switch time, or pump flow rates double click on the corresponding 
box and type in the desired number in the Script window. 

To open the desired valves in a step, click on the appropriate valve boxes in the 
Script window (clear the boxes) in that step. 

To add a step at the end of the script, position the mouse pointer after the last step in 
the sequence and click “+”. Configure the valves, pump flow rates, and switch times 
for each step by checking/unchecking the appropriate boxes under the 
corresponding valve names in the Script window and entering the desired flow rates 
in ml/min and switch time in seconds.  

To remove a step, select it by clicking on the Step cell in the appropriate step, and 
the click on the “-” button. 
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To move a step, drag the step to the desired position in the script. 

It is often convenient to modify multiple steps in a script at the same time, for 
example to set the switch time and pump flow rates for all steps. Multiple steps in a 
range can be selected clicking on the first step to be modified, then while holding 
down the shift key, clicking on the last step to be modified. Figure 9 shows a Script 
window with multiple steps selected. Non-consecutive steps can be selected by 
holding down the command key while clicking on the desired steps. Pump flow rates, 
switch time, and valve state changes entered while multiple steps are selected will be 
applied to equally to all selected steps. 

Figure 9. Script window with multiple steps selected 

NOTE:  When writing a script or working in the Script window, be careful to select 
steps only by clicking on the Step number in the Script window; clicking on any of the 
valve cells will change its status (open or closed). 

When the script is finished, click the lock icon to prevent accidental changes, select 
“Save as” under the File menu, type in a filename, note its location (Where), and click 
Save. 

5.3.3 Running a Script 
To run a script, open the appropriate file as described above. When the system is 
ready (system powered up, columns connected, solvent and sample reservoirs 
prepared, detectors and fraction collectors connected and warmed up), click on the 
“Start script” button and the run begins – the valves will open/close and pumps will 
start as programmed in the script. 

During the run, it is likely the script will need to be interrupted briefly to change 
solvents or perform other operations. At the desired time, click on “Stop script,” 
perform the operation, and restart the script. The script will restart at the time where it 
was originally stopped. 

Note that during the run, the valve configuration of the active step in a script is shown 
in the Script window and also on the top panel LED display on the Control Module. 
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After the run is finished, flush the system with appropriate desorbent followed by 
storage solution. The script can be continued for these operations, or the script can 
be stopped and the operations can be performed manually by opening and closing 
the appropriate valves in the Current Valve State window and running the pumps 
from the Pump Control window. Shut down the system as described in Section 4. 


